
 

Course:  Basic Information Technology Skills  
 
 
 
 
 
 
 
 

Lecture 10 

 

 

MS Excel, workbook, tools, commands, creating data, working with  

data, working with columns/raw, sheets,  mathematical and logical 

formulas using standard spreadsheet functions 

 
 
 

 

 

 

 

 

 

 

Prof. Tuyatsetseg Badarch, PhD, MBA. 

 

 

 

 

                                                       2023 

 

 

 



                                           MICROSOFT EXCEL 

 

4.1 Програмын товч танилцуулга 

Энэхүү програм нь их хэмжээний тоон буюу хүснэгтэн мэдээлэлтэй ажиллах, мэдээллийн сан 

боловсруулах, томъёо, тооцоолол, график, диаграмтай ажиллахад хялбар, боловсронгуй 

болсон хүснэгтэн мэдээлэл боловсруулах хэрэглээний програм юм.  

Excel юу хийж чадах вэ?  

Тоон утгууд дээр тооцоо хийнэ.  

- Өөрчлөлт, засварлалт хийнэ.  

- Өгөгдлийг хэд хэдэн хэлбэрээр харуулна.  

- Өгөгдлийг эрэмбэлнэ. 

- Хийсэн алдааг засна.  

- Үг зүйн алдаа шалгана.  

- Хэвлэхийн өмнөх байдлыг харуулна.  

- Тоон утгаар график зурна.  

- Жагсаалт зохион байгуулна. 

Дэлгэцийн зохион байгуулалт 

Excel програмыг эхлүүлэхэд тоон мэдээлэл бичих хүснэгт гарна. Үүнийг Ажлын дэвтэр 

(Workbook) гэнэ. (Зураг 1) 

 

 

 

Зураг 1.  MS Excel дэлгэцийн зохион байгуулалт

 

Row - Мөр 

Cells - Нүд 

Column - Багана 

Sheet – Ажлын хуудас 
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Workbook буюу Book1, Book2 ажлын хавтаснууд нь Sheet1, Sheet2 гэх мэт ажлын 

хуудаснуудаас тус тус тогтдог. Ажлын хуудас нь 16384 багана, 1048576 мөр, 17179869184 

нүднээс тогтох электрон хүснэгт юм.  

Гарчгийн мөр (Title bar) 

Гарчгийн мөрд ажиллаж буй хэрэглээний програмын нэр (Microsoft Excel) нээлттэй байгаа 

хүснэгтийн нэр (Bookl), цонхны хэмжээ өөрчлөх товчнууд (Scroll bar) зэрэг байрладаг. (Зураг 

4.1) 

Командын мөр (Menu bar)  

Цэсийн мөр нь Excel програмын командуудыг агуулсан байдаг. (Зураг 1) 

Томъёоны мөр (Formula bar) 

Ажлын талбарын дээд хэсэгт томъёоны мөр байрлана. Томъёоны мөрийн эхний хэсэгт 

идэвхтэй нүдний хаяг буюу сонгосон мужийн хэмжээ бүхий тухайн томъёоны хэрэглэгдэх 

хүрээг заасан талбар байрлана. (Зураг 4.1) 

Гүйлгэх хэсэг (Scroll bar) 

Дэлгэцэнд харагдахгүй байгаа хүснэгтийн хэсгийг гүйлгэх мөр ашиглан харж болно. Гүйлгэх 

мөр нь босоо буюу хэвтээ чиглэлд байрладаг. (Зураг 4.1) 

Багана (Column)  

Баганууд нь А, В, С, ........, Z, AA, AB, AC, …, AZ, BA, BB, BC,…, BZ, ….., IV гэсэн латин 

үсгээр нэрлэгдэнэ. Төгсгөлийн багана дээр очихын тулд Ctrl + → хос товчлуур дарна. (Зураг 

4.1) 

Мөр (Row) 

Мөрүүд нь 1,2,3,4,......., 1048576 гэх мэт тоогоор дугаарлагдана. Төгсгөлийн мөрөнд очихын 

тулд Ctrl+ ↓ хос товчлуур дарна. (Зураг 4.1) 

Нүд (Cell)  

Нүд нь багана, мөрийн огтлолцлоор үүснэ. Курсор байрласан нүд буюу Name Box  талбарт 

хаяг нь бичигдсэн нүдийг идэвхтэй нүд гэнэ. Идэвхтэй нүдний хаяг нь тухайн нүдийг агуулж 

байгаа багана болон мөрийн дугаараас тогтоно. Жишээ нь: A1 нь A баганын 1-р мөрөнд 

байрлах нүд. (Зураг 4.1) Ажлын талбарт хуваагдсан нүднүүдийн шугамыг үндсэн шугам 

(Gridlines) гэнэ. 

Нүд нь дараах шинжтэй. 

 Нүд нь текст болон тоо агуулж болно. 

 Математик үйлдлийг хийх томъёо агуулж болно. 

 Нүд бүрийн хувьд текстийн фонд, хүрээний өнгө, хэлбэр зэрэг төрөл бүрийн 

хэвжүүлэлтийг гүйцэтгэж болно. 

Муж (Range) 

Хэд хэдэн нүднүүдийг онцлон сонгосон нүднүүдийг муж гэж нэрлэнэ. Тэгш өнцөгт дүрсийг 

үүсгэж байгаа мужийн эхний зүүн дээд нүдий хаяг, төгсгөлийн баруун доод нүдний хаягийн 

дунд тодорхойлох цэг бичиж тэмдэглэнэ. (Зураг 4.1) 

             MS Excel цэснүүдийн үүрэг, зориулалт 

Home цэс (Зураг 2) нь 

 



Зураг 2. Home Цэс 

Clipboard – хуулах, зөөх, наах үйлдлийн багц 

Font – нүдэн дэх текстийн форматлах үйлдлийн багц 

Alignment – нүдэн дэх текстийн зэрэгцүүлэлт  

Number – нүдэн дэх тооны хэлбэрийн сонголт  

Styles –  хүснэгтэнд бэлэн загвар оруулах 

Cells –  хүснэгтийн мөр, багана нэмэх, устгах хэлбэржүүлэх 

Editing – засварын багц командууд гэсэн үндсэн 7 бүлгүүдтэй бөгөөд эдгээрийг ашиглан 

хүснэгтэн мэдээлэлтэй ажиллана. 

Insert цэс (Зураг 3) 

 
Зураг 3 Insert цэс 

Insert хэсгээс та өөрийн хийж буй хүснэгтэндээ зураг, Excel-ийн өөрийн бэлэн зураг, дүрс, 

хэлбэртэй текст, тэмдэгтүүд болон графикийг 2 юмуу 3 хэмжээстээр хүссэн хэлбэрээрээ 

байгуулж болох ба өөр програмыг объект байдлаар дуудаж оруулж ирж болно. 

Page Layout цэс (Зураг 4) 

 
Зураг 4 Page layout цэс 

Энэ хэсэг нь хуудасны тохиргоо хийх, хүснэгтэнд бэлэн загвар, өнгө өгөх зориулалттай. 

Жишээлбэл: Үндсэн хуудасны тохиргоо хийхээс гадна хуудас тамгалах, өнгө өгөх, хүрээ 

оруулах гэх мэт командууд байрлана. 

 

Formulas цэс (Зураг 5)  

 
Зураг 5 Formulas цэс 

Бүх төрлийн функцийг оруулж ирж та өөрийн хийж буй хүснэгтэндээ ашиглаж болно. Томъёо, 

функцтай ажиллах хэсэгт дэлгэрэнгүй заасан байгаа. 

Data цэс (Зураг 6) 



 
Зураг 6 Data цэс 

Мэдээллийн сантай ажиллах командуудын багцуудтай. Жишээлбэл: Хүснэгтэн дэх өгөгдлийг 

өсөхөөр, буурахаар эрэмбэлэх, шүүлт хийх, нэг нүдэнд байгаа урт текстийг 1 текст бүр 1 

нүдэнд байрлуулах зэрэг олон командуудтай. 

Review цэс (Зураг 7)  

 
Зураг 7 Review цэс 

- Proofing – Энэ хэсэг нь англи хэлний алдаа засна. 

- Comments – Ажлын талбарт тайлбар оруулна. 

- Changes – Ажлын талбар болон файлд нууц үг оруулна. 

View цэс (Зураг 8) 

 
Зураг 8 View цэс 

Дэлгэцийн харагдах хэлбэрийг өөрчлөх, цонхтой ажиллах, Macros гэсэн бүлгүүдээс тогтоно. 

 

   Excel програм дээр өгөгдөлтэй ажиллах 

 Өгөгдөл оруулах (Зураг 9)  

Нүдэнд текстэн болон тоон утгыг оруулж болно. Утгыг оруулаад 

Enter товчийг дарснаар дараагийн мөрөнд автоматаар шилжинэ. Тоон 

утга нүдний баруун талд, текстэн утга нүдний зүүн талд байрлана.                                        

                  Зураг 9 Өгөгдөл оруулах 

 Өгөгдлийн шинжүүд (Зураг 10) 

File->Options->Customize Ribbon->Go To..…. нээгдэх Go To Special харилцах цонхны Select 

бүлэгт:  

Гараас Ctrl+G, F5 товчоор Go To Special цонхыг дуудаж болно. 

Comments: Тайлбартай нүд 

Constains: Тогтмол утгатай нүд 

Formulas: Томъёоны утгатай нүд 

Numbers – Томъёоны утга нь тоон утгатай нүд        

Text – Томъёоны утга нь текстэн утгатай нүд 



Logicals – Томъёоны утга логик утгатай нүд 

Errors – Томъёоны утга алдааны утгатай нүд 

Blanks: Хоосон нүднүүд                                                                                     

Current region: Идэвхтэй нүд бүхий хоосон мөр 

баганаар хүрээлэгдсэн муж, эмхэтгэсэн хүснэгтийн 

муж 

Current array: Идэвхтэй нүд бүхий массивын муж               

Objects: Объектууд 

Row Differences: Тэмдэглэгдсэн мужийн идэвхтэй 

багана ба тухайн мөрийн огтлолцолд орших өгөгдлөөс 

ялгаатай өгөгдөлтэй нүднүүд 

Column Differences: Тэмдэглэгдсэн мужийн идэвхтэй 

мөр ба тухайн баганын огтлолцолд орших өгөгдлөөс 

ялгаатай өгөгдөлтэй нүднүүд 

Precendents: Идэвхтэй нүдний өгөгдөлд нөлөөлөгч 

нүднүүд 

Dependents: Идэвхтэй нүдний өгөгдлөөс хамаарагч 

нүднүүд 

Direct only: Шууд хамаарагч нүднүүд 

All levels: Хамаарагч бүх нүднүүд 

Last cell: Өгөгдөлтэй буюу форматлагдсан сүүлчийн нүд  

Visible cells only: Нууцлагдаагүй нүднүүд 

Conditional formats: Нөхцөлт форматтай нүд 

Data validation: Хязгаарлагдсан өгөгдөлтэй нүд 

All – Хязгаарлагдсан өгөгдөлтэй бүх нүд 

Same – Тэмдэглэгдсэн нүдтэй адилхан хязгаарлалтай нүд зэрэг шинжүүд хамаарна. 

 Өгөгдөл хуулах 

Ижил утгатай өгөгдөл буюу томъёог хуулахад дараах аргуудыг ашигладаг. Эдгээрт: 

1-р арга. Команд ашиглах 

1. Хуулах нүд, мөр, багана, мужийг сонгоно. 

2. Copy команд сонгоно. (Home->Clipboard->Copy, Ctrl+C, Хэрэглүүр)  

3. Хуулж аваачих нүд, мөр, багана, мужийг сонгоно. (курсор байрлуулна) 

4. Paste команд сонгоно. (Home->Clipboard->Paste, Ctrl+V, Хэрэглүүр) 

2-р арга. Хулганы тусламжтайгаар 

Идэвхтэй нүдний баруун доод буланд байрлах жижиг хар битүү цонхон дээр хулганы заагчийг 

байрлуулахад хулганы заагч жижиг хар нэмэх тэмдэг (+) болж хувирах үед доошоо хуулах бол 

доошоо, ар тийш нь мөрийн дагуу хуулах бол арагшаа чирнэ. 

3-р арга. Хулгана, командыг хамт ашиглах 

Хуулах мөр буюу баганаа идэвхжүүлж байгаад: 

- Мөрийн дагуу хуулах бол (Ctrl+D) 

- Баганын дагуу хуулах бол (Ctrl+R) команд сонгоно. 

4-р арга. Sheet буюу ажлын хуудас дамнуулж хуулах: 

1. Sheet1 хуудсанд байгаа өгөгдлийг Sheet2-руу хуулахын тулд Sheet2 хуудсан дээр курсороо 

байрлуулна. 

2. =Sheet1!B2 томъёог оруулаад Enter дарна. Sheet1 хуудсан дээр байгаа B2 нүдний өгөгдөл 

хуулагдана. 

3. Уг нүдийг сонгоод 2-р аргын адил бусад өгөгдлийг хулганаараа чирж хуулж болно. 

Зураг 10  Go To Special 

харилцах цонх 



Жич: хэрэв энэ аргыг хэрэглэсэн үед Sheet1 дээр байгаа B2 өгөгдлийг засварлах үед Sheet2 

дээр хуулагдсан өгөгдөл автоматаар дагаж хуулагддаг. Энэ арга ижил өгөгдлийг олон хуудсанд 

давтаж хэрэглэх тохиолдолд ашигтай. 

 Өгөгдлийг засварлах, нэмэх, устгах 

Өгөгдлийг алдаатай, буруу оруулсан үед засварлах шаардлага гардаг. Энэ үед нүдэнд курсор 

анивчсан хэлбэрээр байрлаагүй байх тул гараас BackSpace, Delete товчийг дарахад тухайн 

нүдэнд байрлах бүх өгөгдөл устдаг. 

Засварлах, өгөгдөл нэмэх аргууд: 

- Нүдэнд курсороо байрлуулаад хос даралт хийх. 

- Гараас F2 товчлуур дээр дарах. 

- Томъёоны мөрөнд хулганаа байрлуулан нэг дарах буюу хулганы заагуур │ хэлбэртэй 

болоход мэдээллээ засварлана. 

Устгах, арилгах (Зураг 11) 

Нүдэн дэх өгөгдлийг устгах буюу арилгах аргууд       

1. Гараас Delete, BackSpace товчлуурыг дарна. 

2. Home->Editing->Clear команд сонгоно.  

   Clear All- Сонгосон нүдэнд оруулсан бүх өгөгдлийг устгана. 

Clear Formats- Сонгосон нүдэн дэх өгөгдлийн хэлбэрийг 

устгана. 

Clear Contents- Сонгосон нүдний агуулгыг устгана.                            

Clear Comments- Сонгосон нүдэнд хийсэн тайлбаррыг устгана. 

Clear Hyperlinks- Сонгосон нүдний холбоосыг устгана. 

 

Зураг 11 Өгөгдөл устгах                                              

  Мөр, багана, ажлын хуудастай ажиллах  

Баганын өргөнийг өөрчлөх 

Баганын стандарт өргөн 8.43 (64 pixels) хэмжээтэй байна. Баганын байрлуулах хүснэгтийн 

толгойд зохицуулан шаардлагынхаа хэмжээгээр (0-255) өөрчилж болно. 

Баганын өргөнг өөрчлөх аргууд: 

1-р арга: Хулганы тусламжтайгаар өөрчлөх.  

Өөрчлөх баганын нэрүүдийн мөрөн дэх хоёр баганын хил 

дээр хулганы заагчийг байрлуулаад сумны чиглэлийн дагуу 

чирч өөрчилнө. Энэ үед зүүн талын баганын өргөн хэрхэн 

өөрчлөгдөж байгааг харуулсан мэдээлэл Column Width 

үгийн ард гарна. 

2-р арга: Column Width командаар өөрчлөх (Зураг 12)  

1. Багануудыг сонгоно.  

2. Home->Cells->Format->Column Width дэд команд 

сонгоно. 

3. Нээгдэх Column Width харилцах цонхны Column 

Width талбарт өргөнийг оруулна. 

4. Ok товчлуур дээр дарна.   

                                          Зураг 12 Column Width 

 

 

 

 

 

 



3-р арга: Динамик цэсний Column Width командаар                      

1. Багануудыг сонгоно. (Зураг 13) 

2. Хулганы баруун талын товчлуур дарахад нээгдэх динамик цэсээс Column Width команд 

сонгоно. 

3. Нээгдэх Column харилцах цонхны Column Width талбарт өргөнийг оруулна. (Зураг 14) 

4. Ok товчлуур дээр дарна. 

   

 

 

 

 

 

 

 

 

    Зураг 13 Багана сонголт                                        

 

 

 

 

  

 

 

 

 

 

 

 

 

 

Зураг 14  Баганын өргөн сонголт 

 

Мөрийн өндрийг өөрчлөх: 

Мөрийн стандарт өндөр 12.75 (17 pixels) хэмжээтэй байна. Мөрийн өндрийг өөрчлөх аргууд:  

1-р арга: Хулганы тусламжтайгаар өөрчлөх. 

Өөрчлөх нэрийн мөрөн дэх хоёр мөрийн хил дээр хулганы заагчийг сумыг чиглэлийн 

дагуу чирч өөрчилнө. Энэ үед дээд талын мөрийн өндөр хэрхэн өөрчлөгдөж байгааг харуулсан 

мэдээлэл Height: үгийн ард гарна. 

2-р арга: Row Height командаар өөрчлөх. 

1. Багануудыг сонгоно. 

2. Home->Cells->Format->Row Height дэд команд сонгоно. 

3. Нээгдэх Row Height харилцах цонхны Row Height талбарт өргөнийг оруулна. 

4. Ok товчлуур дээр дарна.        

3-р арга: Динамик цэсний Row Height командаар өөрчлөх. 

1. Багануудыг сонгоно.  

2. Хулганы баруун талын товчлуур дарахад нээгдэх динамик цэсээс Row Height команд 

сонгоно. 

3. Нээгдэх Row Height харилцах цонхны Row Height талбарт өргөнийг оруулна.  

4. Ok товчлуур дээр дарна. 



Мөр, багана ажлын хуудас нэмэх 

Нүд нэмэх (Зураг 15) 

Home->Cells->Insert->Insert Cells…. замаар 

Хулганы баруун талын товчин дээр дарахад гарч ирэх динамик 

цэснээс Insert командыг сонгоно. Гарч ирэх цонхноос: 

Shift cells right – идэвхтэй нүдийг баруун тийш нь шилжүүлэх 

нүд нэмнэ. 

Shift cells down – идэвхтэй нүдийг доош нь шилжүүлэх нүд 

нэмнэ. 

Entire row – идэвхтэй мөрийг доош нь шилжүүлж мөр нэмнэ. 

Entire column – идэвхтэй баганыг баруун тийш нь шилжүүлж 

багана нэмнэ.                    Зураг 15 Нүд нэмэх 

  

1. Мөр, баганаа идэвхжүүлнэ. 

2. Нэмэхийн тулд: 

- Хулганы баруун талын товчлуур дарахад гарч ирэх динамик цэсээс Insert командыг 

сонгоно. 

- Мөр нэмэх бол Insert->Rows командыг сонгоно. 

- Багана  нэмэх бол Insert->Columns командыг сонгоно. 

Ажлын хуудас (Sheet) нэмэх 

1-р арга: 

Home->Cells->Insert->Insert Sheet 

2-р арга (Зураг 16)       

- Sheet ажлын хуудсаа сонгоно. 

- Хулганы баруун талын товчлуур дарахад гарч ирэх динамик 

цэсээс Insert командыг сонгоно. 

- Гарч ирэх Insert харилцах цонхонд нээгдэх ажлын хуудасны 

хэлбэрийг сонгоно. 

                       

Зураг 16  Ажлын хуудас 

 Мөр, багана устгах 

1. Мөр, баганаа идэвхжүүлнэ. 

2. Устгахын тулд: 

- Хулганы баруун товчийг сонгон гарч ирэх динамик 

цэснээс Delete командыг сонгоно.                                     

- Home->Cells->Delete->Delete rows, columns   

(Зураг 17)      

 

 

Зураг 17 Ажлын хуудас устгах 

 

 Ажлын хуудас устгах                                                                                                          

1. Ажлын хуудасны баруун товчийг сонгон гарч ирэх жагсаалтаас Delete командыг 

сонгоно. (Зура 16) 

2. Home->Cells->Delete->Sheet Delete командыг сонгоно. (Зураг 17) 

Мөр, багана, ажлын хуудасны командууд 



Тухайн мөр, ажлын хуудсан дээр хулганы заагчийг байрлуулаад баруун талын товчийг 

дарахад гарч ирэх динамик цэснээс (Зураг 16-17) 

- Insert – нэмэх 

- Delete – устгах 

- Rename – нэр солих 

- Row Height – мөрийн өндөр 

- Column Width – баганын өргөн 

- Clear Contents – өгөгдлийг устгах 

- Hide – нуух 

- Unhide – нуугдсан ажлын хуудсыг хэвийн байдалд оруулах 

- More or Copy – ажлын хуудсыг зөөх буюу хуулах 

- Select All Sheets – ажлын хуудсыг идэвхжүүлэх  

- Tab Color – ажлын хуудасны нэрийг дурын өнгөөр будах 

 

Мөр, баганыг бэхлэх  

Олон багана, мөртэй хүснэгтийн хувьд хүснэгтийн эхний багана, эсвэл эхний мөрийг 

хөдөлгөөнгүй байлгах шаардлага гардаг. (Зураг 18) Хүснэгтээс мөр, баганыг бэхлэхэд: 

1. Зөвхөн мөр бэхлэх бол хөдөлгөөнгүй байх мөрийн доод талын мөр, эхний багана дахь 

нүдээ идэвхжүүлнэ. Зөвхөн багана бэхлэх бол хөдөлгөөнгүй байх баганын ар талын 

багана, эхний мөрөнд байгаа нүдээ идэвхжүүлнэ. 

2. View->Window->Freeze Panes командыг сонгоно.  

- Freeze panes – Хэсэг хүснэгтийг цоожлоно. 

- Freeze top row – Мөр цоожлоно. 

- Freeze first column – Багана цоожлоно. 

 

Зураг 18 Мөр багана бэхлэх 

  Ажлын талбарыг форматлах 

Тухайн ажлын талбарын хэлбэр, өнгө, хэмжээ, дүрслэл, нүдэн дэх байрлал, хүрээ, шугамын 

урт, өргөн, дүрсийг өөрчлөн тохируулж хэлбэржүүлэхийг форматлах гэж нэрлэнэ.  

Форматлах үйл явцад Format цэс болон Home->Alignment хэрэглүүрийн командууд чухал 

үүрэг гүйцэтгэнэ. 

MS-Excel  програм  дээр Format Cells командын харилцах цонхны тусламжтайгаар 

өгөгдлийг форматлана.  

Мэдээлэлд зэрэгцүүлэлт хийх (Зураг 19) 



Excel програмын үндсэн тохиргоо ёсоор нүдэнд текст шивж оруулах үед текстэн өгөгдөл  

нүдний зүүн талд харин тоон өгөгдөл оруулахад нүлний баруун талд зэрэгцэн байрладаг. 

Нүдний өгөдлийн байрлалыг Home багцын Alignment бүлгийн хэрэглүүрүүдээс сонгоно. 

Нүдний өргөний хэмжээнээс урт текст оруулах үед текст дараагийн нүдэнд дамнан харагддаг. 

Хэрэв зөвхөн тухайн нүдэнд өгөгдлөө харуулах бол текстээ хуваан байрлуулах шаардлагатай. 

Ингэхдээ Home багцын Wrap Text товчийг сонгоно эсвэл 2 баганын хооронд хулганы заагчийг 

байрлуулж, 2 тийшээ харсан сумыг чирэн нүдэндээ өгөгдлөө багтааж болно. 

Зураг 19 Aligment бүлгийн хэрэглүүр 

 -өгөгдлийг нүдний зүүн, төвд, баруун зэрэгт 

байрлууна.  

 

 

 

- өгөгдлийг нүдний дээд, дунд, доор байрлууна. 

 

 

- өгөгдлийг налуу босоо зэрэг байрлалд байрлуулна. 

 

Ажлын талбарыг форматлах 

1. Format >Cells  команд  

2. Динамик цэснээс 

3. Гарнаас Ctrl+1 өгөх 

замаар  нээж болно. 

Format Cells командын харилцах 

цонхонд  Number, Alignment, Font, 

Border, Patterns, Protection, Justify, 

Orientation гэх мэт олон чухал 

тохиргоонуудыг хийнэ. 

Нарийвчлан авч үзье: (Зураг.20) 

Number хэсэг: 

Тооны дүрслэлийг өөрчилнө. 

Талбараас тооны форматын нэрийг 

сонгоно.Үүнд тооны бүхэл хэсэг, 

бутархай, сөрөг тоо, тооны тусгай 

тэмдэгтийн тэмдэглэгээ (мөнгөн  

тэмдэг $, ₮), огнооны хэлбэр, цаг 

хугацааны хэлбэр, утас, факсын 

дугаар, кодын формат. 

 

Зураг 20 Мөр багана бэхлэх 

 

 

Alignment хэсэг:  

Өгөгдлийн тухайн нүдний  доторх байрлал, үүнд: хэвтээ болон босоо тэнхлэг дэх байрлал, 

өнцөг үүсгэх, цувуулах, нүд нэгтгэх, нүдэнд багтаах, нүдэнд шинэ мөр  үүсгэх  

Fond хэсэг:  

Фондны төрөл хэлбэр хэмжээ өнгө доогуур зураас эффект оруулах  

Border хэсэг: 

Зураг 4.20  Format Cells командын 

тохиргоо 

Бичих 

чиглэлийг 

заах хэсэг 

Босоо тэнхлэгийн 

дагуу мэдээлэлд 

хийх зэрэгцүүлэлт 

Өнцгийн 

хэмжээ  

заах товч 

Хэвтээ тэнхлэгийн 

дагуу мэдээлэлд 

хийх зэрэгцүүлэлт 



Нүдэнд хүрээ шугам үүсгэх, хүрээний  төрөл өнгө харагдах хэлбэрийг сонгох хүчингүй болгох  

Patterns хэсэг: 

Идэвхтэй нүдэнд дэвсгэр өнгө зурааслах хэлбэр юм. 

Protection хэсэг: 

Өгөгдлийг засварлах ба  томъёог нууцлах. Эндээс Alignment хэсгийг дэлгэрүүлэн тайлбарлъя. 

Нүд болон  мужтай  холбогдох бүх л тохиргоог хийнэ. 

Horizontal: Хэвтээ чиглэлд өгөгдөл байрлах хэлбэр. 

- Left(Indent) –Зүүн, Indent догол мөр гаргах, тодорхой зайд байрлуулах үед Indent 

талбарт зайг оруулна. 

- Center-төв (Нүдний  голд) 

- Right-баруун  

- Fill-нүдэнд багтах хэмжээгээр дүүргэнэ 

Justify- нүдэнд жигд тарааж байруулах  

Center Across Selection - зэрэгцээ хэд хэдэн нүдний голд түүний эхний нүдэнд бичигдсэн 

өгөгдлийг байруулах  

Vertical: Нүдний босоо чиглэлд өгөгдөл байрлах хэлбэр. Top-дээд шугаманд шахна 

Center –босоо чиглэлд голлуулна  

Bottom-доод шугаманд шахна 

Justify-босоо  чиглэлд жигд тараана   

Text control: Текстэн өгөгдлийг удирдах. 

Wrap text – өгөгдлийг нүдний  өргөний хэмжээгээр мөрөнд хуваана  

Shring to fit – өгөгдлийн үсгийн хэмжээг багасгаж нүдэнд багтаана 

Merge Cells – идэвхтэй нүднүүдийг нэгтгэж нэг нүд болгоно. 

Orientation: Өгөгдлийн бичигдэх өнцгийг тодорхойлно. 

 Хүрээ үүсгэх (Зураг 21) 

Excel програмын тусламжтайгаар өгөгдлүүдийг хүснэгтлэх, өөрөөр хэлбэл, мэдээллийн 

харагдацыг ойлгомжтой болгох үүднээс хүрээ шугамуудыг тодруулах татах үйлдлийг хүснэгт 

татах гэнэ. Мэдээллийг дахин боловсруулахгүй тохиолдолд хүснэгт татах нь энгийн бөгөөд 

хэрэглэхэд ойлгомжтой.(Зураг 21)  

1. Хүснэгт татах мужийг тэмдэглэнэ. 

2. Home цэсийн Font бүлгийн Border   хэрэглүүрийн арын сумтай товчийг дарахад 

цэс нээгдэнэ. Цэсээс идэвхжүүлсэн хэсгийн дээр, доор, зүүн, баруун талд нь эсвэл бүх 

талд нь гэх мэт өөрийн зорилгод  нийцсэн хүрээг сонгоно. 

3. Format Cells харилцах цонхыг нээнэ. Нээгдэх Format Cells харилцах цонхны Border 

хавтаст хандана. Шугам татах хүрээг Presets бүлгээс, тухайн нэг талд шугам татахыг 

Border бүлгээс, шугамын хэлбэрийг Line бүлгийн Style талбараас, шугамын өнгийг Color 

талбараас тус тус сонгоно. 



 
Зураг 21  Format Cells харилцах цонхны Border хавтасны хэсэг 

  

Нүд нэгтгэх ба нэгтгэсэн нүднүүдийг салгах: Зарим тохиолдолд ажлыг хуудасны хэсэгт 

гарчиг өгөх маягаар хэд хэдэн мөр, эсвэл баганыг нэгтгэх шаардлага гардаг ингэхдээ Home 

багцын Alignment бүлгийн   хэрэглүүрээс Merge cells харин нэгтгэсэн нүдийг буцаахдаа 

Unmerge cells командыг сонгоно.   

  

Мужийнн оператор ашиглах: Функц ашиглахын тулд мужын операторуудын ашигладаг. 

Мужийн операторуд нь нүднүүдийг бүлэглэдэг. Мужийн хаяг нь хоёр нүдний хаягийг хооронд 

нь тодорхойлох цэгээр тусгаарлагдсан байдаг. A1:C3 мужид A1, A2, B1, B2, C1, C2, C3 

нүднүүд багтана. Хоёр ба түүнээс дээш тоо, муж, нүдний хаягуудыг муж нэгтгэх оператор 

болох (,) таслалаар тусгаарлан бичсэнийг нэгтгэсэн муж гэнэ. 

                Өгөгдөлтэй ажиллах 

Тооны бичигдэх хэлбэрийг өөрчлөх 

Хүснэгтэнд хэрэглэж байгаа тооны бичигдэх хэлбэрийг хэрэгслийн мөрийн тусламжтайгаар 

өөрчилж болно. Бичигдэх хэлбэрийг өөрчлөх тоо бүхий нүдээ идэвхижүүлээд хэрэгслийн 

мөрөөс товчоо сонгоно. 

Хүснэгт 4.1 Дэлгэц дэх дүрс зургуудын тайлбар 

Хэлбэр Товч 
Жишээ 

Тоо Үр дүн 

Мөнгөний хэлбэрээр бичнэ. 
 

12345  $12,345.00 

Хувь тавина. 
 

.12 12% 

Мянгатын орныг таслалтай бичнэ. 
 

12345 12,345.00 

Бутархайн орны тоог ихэсгэнэ. 
 

12,345.00 12,345.000 

Бутархайн орныг багасгана. 
 

12,345.00 12,345.0 

Тооны хэлбэрийг өөрчлөхдөө хэрэгслийн мөрийн товчноос гадна команд ашиглаж болно.  

Командаар тооны бичигдэх хэлбэрийг өөрчлөхөд тоо бичигдэх нүдээ сонгоно. Та тоо 

бичсэний дараа хэлбэрийг нь өөрчлөх бол тоо бичсэн нүдээ идэвхжүүлнэ. Үүний тулд: 



Home цэсээс Number команд сонгоно. 

Тоо (Number) хэсгийг идэвхжүүлнэ. Category хэсэгт ямар мэдээллийн хэлбэрийг өөрчлөх гэж 

байгааг сонгоно. Тооны хэлбэр өөрчлөх гэж байгаа бол Number  сонголт хийнэ. Тохирох  

хэлбэрээ сонгоод Ok товч дар. 

Тооны бичигдэх хэлбэр өөрчлөх сонголт хийхэд бутархайн орны тоог (Decimal Places) заана. 

Negative Numbers хэсгээс сөрөг тооны тэмдгийг харуулах эсэх, өөр өнгөөр ялган харуулах уу 

гэдгийг сонгоно. Use 1000 Separator () -н өмнө тэмдэглэгээ хийвэл мянгатын орноор нь салгаж 

тэмдэглэнэ. 

Томъёо, текст тоо хайх 

Мэдээллийг хайхдаа Home цэсээс Find команд сонгоно. Хайлт хийх хэсгийн ард (Find What) 

хайх мэдээллээ бичнэ.  

- Search хэсгийн ард байгаа сумыг дарж хаана хайлт хийх хүрээгээ сонгоно. By Row– 

Мөрөөр хайна. By Column- баганаар хайна.   

- Мatch Case- хэсгийн өмнө тэмдэглэгээ хийвэл том жижиг үсгийг ялгаатайгаар хайна.  

- Find Entire Cells Only - хэсгийн өмнө тэмдэглэгээ хийвэл хайж байгаа мэдээлэл бүхий 

нүдийг гаргана.  

- Find Next товчлуураар хайлтыг эхлүүлнэ.  

- Close товчоор хайлт хийх цонхыг хаана.  

- Хайж олсон мэдээллээ солих шаардлага гарвал Replace товч дарна. 

Тэмдэгтийг солих  

Идэвхтэй ажлын талбарын тэмдэглэгдсэн мужид ямар ч төрлийн өгөгдлийг, түүнчлэн өгөгдөл 

дотор солилтыг хийж болно. Үүнд:    

Тоо, томъёо, текстийг солихдоо Home/Editing/Find&Select команд сонгоно.  

- Find What  хэсгийн ард хайх мэдээллээ бичнэ.   

- Replace With  хэсгийн ард солих мэдээллээ бичнэ.  

- Search хэсгийн ард байгаа сумыг дарж хаана хайлт хийх хүрээгээ сонгоно. By Row – 

Мөрөөр хайна. By Column -баганаар хайна.   

- Мatch Case  - хэсгийн өмнө тэмдэглэгээ хийвэл том жижиг үсгийг ялгаатайгаар хайдаг.  

- Find Entire Cells Only - хэсгийн өмнө тэмдэглэгээ хийвэл хайж байгаа мэдээлэл бүхий 

нүдийг гаргана.  

- Find Next товчоор хайлтыг эхлүүлнэ.  

- Close товчоор хайлт хийх цонхыг хаана.  

- Хайж олсон мэдээллээ Replace товчоор солино.  

- Олдсон мэдээллийг бүгдийг солих бол Replace All товч дарна. 

Нүдэнд оруулах өгөгдөлд хязгаарлалт тавих (Зураг 22) 

Тодорхой мужид оруулах өгөгдлийг тодорхой утгаар хязгаарлах, хязгаарлалтын мужийн бус 

өгөгдөл оруулсан тохиолдолд алдааны мэдээлэл бүхий цонх нээгдэх, нүдэнд тайлбар хийх 

зэрэг боломжуудыг Data/Data tools/Data Validation командын хэрэглүүрийн (Зураг 23) 

тусламжтайгаар ашиглах боломжтой. 

 
Зураг 22  Data/Data Tools бүлэг 

Нүдэнд оруулах бодит тоон утгуудад хязгаарлалт тавих 



1. Хязгаарлалт хийх мужийг тэмдэглэнэ. 

2. Data/Data tools/Data Validation командыг 

сонгоно. (Зураг 22) 

3. Нээгдэх Data Validation харилцах цонхны 

Settings хавтаст  

4. Valdidation criteria бүлгийн Allow талбараас 

хязгаарлалт тавигдах өгөгдлийн төрлийг 

сонгоно. (Зураг.23)Үүнд:  

- Төрөл хамаарахгүй тохиолдолд Any value                 

- Бүхэл тоо бол Whole number                                         

- Аравтын бутархай бол Decimal  

- Жагсаалт бол List                                   

- Хугацааны цуврал бол Date    Зураг 23  Data Validation  харилцах цонх 

- Цагийн цуврал бол Time         

- Текстийг уртаар нь хязгаарлах бол Text length 

- Томъёоны үр дүнгээр хязгаарлах бол Custom төрлийг сонгоно.            

5. Бодит тоон хязгаарлалт тавих тохиолдолд Whole number, Decimal төрлийн аль нэгийг 

сонгоно. Data талбараас жишилтийн операторыг сонгох ба энэ талбарын операторуудын 

жагсаалт нь Allow талбарт сонгогдсон төрлөөс хамаарна. Allow талбараас Whole number 

эсвэл Decimal төрлийг сонгосон тохиолдолд Data талбарын жагсаалт нь дараах 

операторуудтай ба энд сонгогдсон оператороос хамаарч 1-2 талбар харилцах цонхонд 

нэмж нээгдэнэ. (Зураг 24)Үүнд: 

- Between оператор: Тэмдэглэгдсэн 

мужид оруулж болох хамгийн бага 

утгыг Minimum талбарт, хамгийн их 

утгыг Maximum талбарт тус тус 

тодорхойлно. Өөрөөр хэлбэл, 

тэмдэглэгдсэн мужид Minimum 

талбарт тодорхойлогдсон утгаас 

багагүй, Maximum талбарт 

тодорхойлогдсон утгаас ихгүй утгыг 

оруулахыг зөвшөөрнө. 

- Not between оператор: between 

операторын эсрэг, өөрөөр хэлбэл 

Minimum талбарын утгаас бага, 

Maximum талбарын утгаас их утгыг 

оруулахыг зөвшөөрнө. 

 

      Зураг 24 Data жагсаалт 

 

- Equal to оператор: Value талбарт тодорхойлогдсон утгатай тэнцүү утгыг оруулахыг 

зөвшөөрнө. 

- Not equal to оператор: Value талбарт тодорхойлогдсон утгатай тэнцүү биш утгыг 

оруулахыг зөвшөөрнө.                                      

- Greater than оператор: Minimum талбарт тодорхойлогдсон утгаас их утгуудыг оруулахыг 

зөвшөөрнө.                                                          

- Less than оператор: Maximum талбарт тодорхойлогдсон утгаас бага утгуудыг оруулахыг 

зөвшөөрнө.    



- Greater than or equal to оператор: Minimum талбарт тодорхойлогдсон утгатай тэнцүү 

буюу их утгуудыг оруулахыг 

зөвшөөрнө.        

- Less than or equal to оператор: 

Maximum талбарт тодорхойлогдсон 

утгатай тэнцүү буюу бага утгуудыг 

оруулахыг зөвшөөрнө.         

6. Нүдэнд мэдээлэл зүүх тохиолдолд Input 

Message, хязгаарлалтын мужийн бус 

утга оруулсан тохиолдолд мэдээллийн 

болон   хориглосон, анхааруулсан 

цонхнуудыг дэлгэцэнд нээх тохиолдолд 

Error Alert хавтаснуудаас зохих 

сонголтыг хийнэ. (Зураг 25)  

7. Ok товчлуур дээр дарна.     

               Зураг 25 Error Alert хавтас 

                                     Томъёотой ажиллах                                                                    

Томъёонд функц болон үйлдлийн оператор, хувьсагч, тогтмол утгуудыг ашиглана. Томъёоны 

үр дүн (утга) нь тогтмол утга байхаас гадна True (үнэн), False (худал) гэсэн логик утга, 

томъёонд алдаа гарсан тохиолдолд алдааны утгыг өгнө. Томъёо нь ямагт = тэмдэгтээр эхэлнэ. 

Тогтмол утга нь, хувьсагч буюу нүдний хаяг, операторууд, функцтай байж болно.  

Томъёоны бичиглэлийн ерөнхий хэлбэр: 

=(A4/12)+B4*2+SUM(A1:A3) 

Нүдэнд томъёо оруулахдаа: 

1. Томъёо оруулах нүдийг идэвхжүүлнэ. 

2. Томъёо оруулах дараах аргуудын аль нэгийг хэрэглэж болно. 

Томъёо бичихийн өмнө = тэмдэг тавина. Томъёо оруулаад Enter дарна. Оруулсан томъёоны 

мөрөнд гарна. (Зураг 26) 

Томъёоны мөрөн дэхь Insert Function хэрэгслийг сонгож гарч ирэх Insert Function 

харилцах цонхноос шаардлагатай функцийг сонгоно. Нээгдэх Function Arguments харилцах 

цонхонд томъёоны хамрагдах мужийг тэмдэглэнэ. Ok дарна. 

Insert Function харилцах цонх: (Зураг 27) 

Төрөл бүрийн функцууд ашиглан хүснэгт дэх тоон мэдээлэлд тооцоо хийж болно. Функцийг 

томъёоны мөр дээр бичдэг. Хэрэглэгч өөрөө функцээ бичиж болохоос гадна бэлэн бичиглэлийг 

ашиглаж болно. Бичиглэлийг Insert цэсээс Function команд сонгон хэрэглэнэ. Эсвэл стандарт 

хэрэгслийн мөрөөс Insert Function (Shift+F3) товч хэрэглэнэ.  

Саяхан ашиглагдаж байсан - Most Recently Used  

Search for a function – функц хайх 

Or select a category- функцийн төрөл 

Most Recently Used- түгээмэл хэрэглэгддэг функцууд 



1. All-Бүх функцууд 

2. Financial-Санхүүгийн функцууд 

3. Date & Time -Хугацааны функцууд 

4. Math & Trig- Математик тригонометрийн 

функцууд            

5. Statistical – Статистикийн функцууд  

6. Lookup&Reference- Хаяг ба мужтай ажиллах 

7. Database– Өгөгдлийн сантай ажиллах 

функцууд 

8. Text- Тексттэй ажиллах функцууд  

9. Logical- логик функцууд 

10. Information- Мэдээллийн функцууд 

11. Engineering-Инженерчлэл функцууд  

      Зураг 26 Нүдэнд томъёо оруулах 

 

        
Зураг 27 Insert Function харилцах цонх 
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